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Preface

Thank you for purchasing this Sokkia product. The materials available in this Manual (the “Manual”) have been prepared by Topcon
Positioning Systems, Inc. (“TPS”) for owners of Sokkia products, and are designed to assist owners with the use of the receiver and
its use is subject to these terms and conditions (the “Terms and Conditions”).

Please read the terms and conditions carefully.

Terms and Conditions Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local government protection agency for both private use and
commercial job sites.

Copyrights

Allinformation contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved. Do
not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access to,
any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such information
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for the care and operation of the receiver. The information and data in this Manual are a valuable asset of TPS and are developed
by the expenditure of considerable work, time and money, and are the result of original selection, coordination and arrangement
by TPS.

Trademarks

GRX™, SRU™, Magnet™, Pocket-3D™, Sokkia® and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned by Bluetooth
SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other product and company names
mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR
LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN
CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER
COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.
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License Agreement

Use of any computer programs or software supplied by TPS and Sokkia or downloaded from a Sokkia website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide
by these Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software
under the terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the
Software or this license without the express written consent of TPS. This license is effective until terminated. You may terminate
the license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of
the Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All
ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not
acceptable, return any unused software and manual.

2dekjold

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver.
Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to
disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other
appropriate remedy.
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Website; Other Statements

No statement contained at the TPS and Sokkia websites (or any other website) or in any other advertisements or TPS literature
or made by an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license,
warranty and limitation of liability).

Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to
conflict of laws.
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Manual Conventions
This manual uses the following conventions:

Convention Description

Bold Menu, or drop-down menu selection
Name of a dialog box or screen
Button or key commands

Mono User supplied text or variable

Italic Reference to another manual or help document

Further information to note about system configuration, maintenance, or setup.

Notification that an action has the potential to result in system damage, loss of data, loss of warranty, or

personal injury.

Terms and Conditions Use P/N: 1001826-01

NS
>
Supplementary information that can have an adverse affect on system operation, system performance, data
integrity, measurements, or personal safety.
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Example

File » Exit (Click the File menu and click Exit)
From the Connection screen...

Click Finish.

Type guest, and click Enter.

Refer to the Sokkia Reference Manual.
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Introduction

Sokkia’s GRX2 receiver is a compact, lightweight, and completely integrated GNSS receiver for static and kinematic applications.
The integrated receiver design includes a 226-channel GNSS receiver board, superior dual frequency antenna, and wireless
communication technology. The GRX2 delivers world-class positioning and navigation capability to your application by tracking
signals from multi-constellation satellite systems, including GPS, GLONASS, and SBAS.

The GRX2 offers complete IP67 protection against dust and water ingress, in addition to superior vibration and shock resistance.
The communication interface allows you to quickly integrate Sokkia’s premium GNSS performance within new systems and quickly
deliver positioning and navigation support to your applications.

Figure 1: GRX2 Receiver
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GRX2 Features

The GRX2 receiver features the following:

* A premier multi-constellation GNSS board

® Superior antenna technology

® Serial (RS-232C) and power ports

® Detachable battery

¢ Ahighly visible display panel with single-button operation
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® External memory card slot
® Integrated Bluetooth® wireless and radio technology
* Optional HSPA (3.5G)! and CDMA Cellular technology
* Voice notifications for important receiver operations
® Integrated and rugged design

The GRX2 comes in one of the following configurations:

® Static (No integrated radio/cellular module)

* Digital UHF Il radio modem

® Digital UHF Il radio modem with HSPA module

¢ Digital UHF Il radio modem and CDMA module (US only)

1. High-Speed Packet Access (HSPA) cellular module supports faster data rate and is backward compatible with GPRS/EDGE (GSM) technology.

GRX2 Features P/N: 1001826-01 2




Unpacking Your Receiver Kit

This section describes the documentation, standard kit components, and accessories (depending on your purchase) that
accompany your receiver. When you unpack your receiver kit, verify you received the items listed in this section. Make sure the
items do not appear damaged from shipment. If any of the items are missing or damaged, contact your Sokkia dealer or Sokkia
technical support. See “Getting Technical Support” on page 6.

® Standard components are illustrated in Figure 2.
® Receiver accessories are illustrated in Figure 3.
® Receiver documentation is listed on page 4.

System Components

The items illustrated in Figure 2 are included with your receiver.

= o .

GRX2 Receiver Serial Cable Carrying Case Battery Charger Battery Charger Cable
T
lec
HiPer \ Manual CD GPS+Software CD LED Display Card ‘Warmranty Card

Figure 2: Standard System Components
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Accessories

Sokkia offers a wide variety of accessories (see Figure 3) specially designed to improve system flexibility and job site efficiency.

For more details on the optional accessories available for GRX2, contact your Sokkia dealer.

Q Q‘ N

Power Charger Cable Power Adapter Receiver Power Cable
.'% |
[- -
" -t -i
Precisi
Precision Tribrach Trhralglu:':;)ter Prism Spacer Measuring Tape

Range Pole

Figure 3: Receiver Accessories

Technical Documents

The GRX2 Manual CD includes three manuals (listed below) that help you set up and use your new receiver quickly and
efficiently.

® GRX2 Operator’s Manual — An on-screen help document that contains detailed information on how to use your new
receiver.

Technical Documents P/N: 1001826-01
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® GRX2 Quick Start Guide — An on-screen help guide that contains instructions for quickly setting up your new receiver and
begin using it.

® Sokkia Receiver Utility (SRU) Reference Guide — An on-screen help document that contains detailed information on how
to use the SRU software included on the GPS+ Software CD. For more information about the SRU software, see “Using
Sokkia Software With Your Receiver”.

Using Sokkia Software With Your Receiver
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Use the GRX2 receiver in conjunction with the Sokkia Receiver Utility (SRU) and MAGNET Field™ applications. Sokkia software
enables you to configure the receiver and other external devices, manage files, collect data, and perform survey and
construction work flows.

SRU is a hardware configuration software for receivers and peripheral devices. You can install it on desktop computers and data
controllers. This program is provided on the SRU Software CD that accompanied your receiver. A SRU help document is provided
on the GRX2 CD.

The MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data collection and
exchange, and field solutions, such as topo, staking, roads, calculations, and more.

Contact your Sokkia dealer for more information about Sokkia software or the GRX2 receiver system.
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Getting Technical Support

Before contacting a Sokkia customer representative about any problems with the receiver, see “Troubleshooting” on page 59 for
some solutions that may fix the issue.

Contact your local Sokkia dealer or visit the Sokkia Support site (www.SokkiaSupport.com) for technical support.

<//\/>g For quick and effective support, provide a detailed description of the problem.

When contacting Sokkia for technical assistance, provide the following information for better and faster service:

1. Adescription of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in SRU, select Save to
File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory and
storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N: 1001826-01
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Website

The Sokkia website provides current information about Sokkia’s line of products. The support area of the website provides access
to Sokkia field and office software, manuals, frequently asked questions, and so forth.

To access the Sokkia website, visit www.sokkia.com.
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To access the Sokkia support site, visit www.sokkiasupport.com.

Phone

To contact Sokkia Customer Support by phone, call:

* 1-800-4-Sokkia or 1-800-476-5542
® 1-866-4-Topcon or 1-866-486-7266
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Getting Acquainted

The GRX2 receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, and wireless communication
devices. The receiver’s enclosure also includes dedicated space for batteries, external memory storage, and a SIM card.

Receiver Overview

The GRX2 receiver’s advanced design reduces the number of cables required for operation, allowing for more reliable and efficient
file data collection.

An easy-to-operate display panel, mounting socket, battery bay door, connection ports (serial, power, and radio antenna), and
labels with receiver information are located on the bottom of the receiver’s magnesium alloy lower enclosure.

The GRX2 receiver has a highly-visible display panel with single-button operation. The display panel enables you to view the
receiver’s operational status. For more information, see “Display Panel Operations” on page 18.

The mounting socket (Figure 4) connects the receiver to either a standard 58" thread pole or adapter.

You can locate regulatory and product identification information on the two receiver labels. The product identification label
contains the serial number and part number.
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Receiver Overview

Modem Antenna

Port
Bluetooth Speaker
Label p
Battery
Compartment
Mounting
Socket

Product ID
Label with Part
Number and
Serial Number Rubber

Bumper

Ports Panel

Figure 4: Bottom Enclosure Overview
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Cables

Cables

NES

-

The GRX2 package includes a serial cable for configuring the receiver. Table 1 describes the cable included with your receiver
and optional cables that are available as accessories.

gently remove the cable.

Table 1. Receiver Cables

Cable Description

Cable lllustration

Serial Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n 72692
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Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock clockwise
until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-clockwise, and then
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Table 1. Receiver Cables

Cable Description Cable lllustration

Battery Charger Cable (Optional)

Connects the power adapter to the battery charger. Several
options are available for the battery charger cable based on your
country. If your kit does not include this cable, contact your
Sokkia dealer. Refer to the these part numbers for available
battery charger cables:

p/n 73113A — Cable, Power, CDC68 (EUR)

p/n 210160124 — Cable, Power, CDC68 (US)

p/n 73113C — Cable, Power, CDC68 (AUS)

p/n 2212113F0 — Cable, Power, CDC68 (Brazil)

Power Charger Cable (Available for Purchase)
Connects the power adapter to a grounded outlet. Sever-

al options are available for the power charger cable based on
your country. To purchase this cable, contact your Sokkia dealer.
Refer to this part number:

p/n 14-008054-01 — Cable, Power Charger (EUR)

p/n 14-008052-01 — Cable, Power Charger (US)

p/n 14-008074-01 — Cable, Power Charger (AUS)

p/n 1000475-01 — Cable, Power Charger, 1.8M (Brazil NMetro)

Cables P/N: 1001826-01



Table 1. Receiver Cables

Cable Description

Cable lllustration

Power Adapter (Available for Purchase)

Charges the receiver when connected to a grounded outlet and
the power charger cable. To purchase this cable, contact your
Sokkia dealer. Refer to this part number:

p/n 22-034101-01 — Power Supply with SAE Connector

Receiver Power Cable (Available for Purchase)

Connects the receiver to the power adapter through the SAE
connector. To purchase this cable, contact your Sokkia dealer.
Refer to this part number:

p/n: 700355130X

&

&

Memory

Memory

The GRX2 is equipped with an accessible SD/SDHC card slot for data storage. As data is logged to the SD/SDHC card, the Memory
Capacity Bar displays the memory capacity status. See “Memory Capacity Bar” on page 22 for more information. To access the

raw data files on the SD/SDHC card, see “Using SD/SDHC Cards” on page 55.

P/N: 1001826-01

12



Detachable Batteries

The receiver first draws power from a connected external power source. When there is no valid external power source
connected or if the source has discharged lower than 7.2V, the receiver will draw power from a rechargeable high-
capacity battery. The GRX2 receiver standard kits include two detachable Li-lon batteries for powering the receiver and
one battery charger. Each battery is capable of running for more than 7.5 hours on a single charge [in static mode with a
Bluetooth® connection and at 68° F (20° C)]. See “Batteries” on page 25 for more information.

~ /gs The batteries are shipped from the factory with a partial charge. For maximum operating time, fully charge the
= batteries before using the receiver.

Voice Notification

The GRX2 receiver has a voice notification feature that issues a series of voice messages and sounds to alert you to different
system status’ and event conditions.

The GRX2 is pre-configured with either voice messages or sounds at a preset volume. To modify volume

5
= settings, use the SRU software or other application software.

The frequency of the voice messages or sounds depends on the specific conditions; the frequency is either once (when the
condition first occurs) or repeated (every 30 seconds for a set period of time).

Detachable Batteries P/N: 1001826-01 13



The following events generate messages from the GRX2 audible annunciator:

Voice Notification

Table 2. Audio Event Index

N EVENT NAME DESCRIPTION

1 LOGEPOCH Message recorded to file

2 STARTUP System has completed startup

3 SHUTDOWN Receiver is shutting down (immediate)

4 BTNPOWER Power Button — Power On

5 BTNFRESET Power Button — Factory Reset

6 BTNFORMAT Power Button — SD Format

7 BTNIGNORE Power Button — Return to normal operation
8 BATTLOW Battery power is low

9 MEMLOW Remaining space on SD memory card is low
10 MEMFULL SD memory card is full

11 RTKFIXED RTK solution is now Fixed

12 RTKFIXLOST RTK solution is no longer Fixed

13 CONNECT Bluetooth has been connected

14 DISCONNECT Bluetooth has been disconnected

P/N: 1001826-01
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Data and Power Ports

The GRX2 has the two ports described below:

¢ Serial - rimmed in black; used for communication between the receiver and an external device. The body of the
connector on the corresponding cable is black.

® Power - rimmed in red; used to connect the receiver to an external power source. The body of the connector on the
corresponding cable is red.

Power

Port

Modem
Antenna
Port

Figure 5: GRX2 Ports
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External Radio Antenna Connector

The antennas for the receiver’s internal UHF radio (and optional cellular modem) connect to the BNC external
antenna connector located under the GRX?2 housing (Figure 6).
The optimal modem antenna depends on the frequency of the UHF radio that is installed in the receiver:

a I

Figure 6: UHF Antenna

e UHF: Uses a BNC RF connection and comes in two versions:
—410-440Hz (30-070003-01)
—440-470Hz (30-050503-01)

* Cellular Antenna: Sold separately (p/n: 1001313-01 ANTENNA, 1/2 WAVE, QUAD BAND W/TNC-To-
BNC adapter)

External Radio Antenna Connector P/N: 1001826-01 16



Connector

The bottom connector (Figure 7) enables you to mount the receiver to either a standard 58" thread pole or adapter.

Bottom Connector
for Standard Setups

paiutenboy 8unjen

Figure 7: GRX2 Bottom Connector
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Display Panel Operations

The GRX2 LED Display Panel is used to display and indicate the receiver’s current operational status. The display offers a
compact but valuable summary of the most important receiver information for the typical user. This chapter describes the
different LED blink patterns and what they mean.

Position Status Bar
Memory Capacity Bar

Wireless Status
\ N\ | __'/

Power —awm=
Button ) 010
/ f
Radio

Battery Status Status

Available Power Bar

Receiver
Health

File Status Serial Port

Tracking Status Status

Figure 8: LED Display Panel
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The LED display table below describes the meaning of the LED icons used in this section.

LED ICON KEY

DISPLAY SOLID BLINKING OFF

. | | [

Power Button performs multiple functions. The number of seconds that the power button is pressed and held determines how
the receiver will behave. At specific time intervals, the receiver issues voice messages or sounds to guide the user through the
available options.

POWER BUTTON FUNCTIONS
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ACTION SECONDS DESCRIPTION
Press for 1

Power ON second The GRX2 powers ON.
Press for 3

Power OFF seconds The GRX2 powers OFF.

WITH POWER ON

Factory Reset Press for 10 |Resets all parameters on the
(Clear NVRAM) seconds GRX2 to their default values.
Erase Erase All Files |-/658 10720 | hojetes all files from the SD/SDHC card
rase Erase iles | seconds eletes all files from the card.
Press for : i
Disregard more than 25 No actllon. Thtg GRX2 will return to
seconds normal operation.
. |Within 2 Start a raw collection to a new file, or
Open/Close Data File seconds close a currently open file.

P/N: 1001826-01 19




Boot during the boot process the display indicates boot progress.

Progress

Display

First

Second Last

Available Power Bar indicates the remaining battery charge or remaining voltage when using external power.

AVAILABLE POWER BAR

DISPLAY

INTERNAL POWER REMAINING

EXTERNAL POWER REMAINING

Greater than 50%
Greater than 25%
Greater than 10%

Less than 10%

Greater than 8V
Greater than 7.25V
Greater than 6.5V
Less than 6.5V

Battery Status LED indicates the currently available power sources for the GRX2.

BATTERY STATUS
[ | Only the internal battery is available.

I | Only external power is available.
Both the battery and external power are available.

P/N: 1001826-01
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Position Status Bar indicates the current type of position computed.

POSITIONING STATUS BAR

- RTK fixed solution.

DGPS or RTK float solution.

- Stand-alone or base mode.

- Invalid or no position.

Tracking Status LED indicates the number and type of satellites currently being tracked by the GRX2.

TRACKING STATUS

ORDER | DISPLAY |STATUS
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1 Il | Blink per tracked GPS satellite.

2 I | Blink if no satellite signal with SNR value >48 dB*Hz.
3 |l |Blink per tracked GLONASS satellite.

4 - Blinks once when no satellites or no solution.

Off otherwise.
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Memory Capacity Bar indicates the percentage of available space on the SD/SDHC memory card.

MEMORY CAPACITY BAR

Greater than 50%

Less than 50%

Less than 25%

Less than 10%

Memory full or SD/SDHC card is not ready.
No card is installed.

]
.
I
- 4l
|

File Status LED indicates the status of the current file.
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I (Afile is open.
I | VVriting to the file.

Afile is not open or there is no SD/SDHC card in the slot.

Communication Status LEDs
Wireless Status LEDs indicate the status COMMUNICATION STATUS (WIRELESS/RADIO/SERIAL PORT)

of the internal Bluetooth module Bluetooth connection is established.
Waiting for Bluetooth connection.

Bluetooth module is not powered.
Internal radio is powered.

Radio Status LEDs indicate the status of the
internal UHF radio and HSPA/CDMA module.

Internal radio is not powered.
Data is being transmitted from the associated port.

Data is being received by the associated port.

Serial Port Status LEDs indicate the status
of serial port.

1
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Timer LED is used in job programming to indicate various states of a job.

- A Timer JOB has started and is waiting to begin file operations.

[l | The file is opened by the JOB.
The file is closed by the JOB or no JOB was activated/executed.

When the GRX2 is powered off and a timer JOB is in waiting, the timer LED blinks once every two seconds momentarily.

-~ /gs After a job has been activated, is waiting for execution, or is being executed, you cannot power off the
2 receiver using the Power button.
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Managing Power

This chapter describes how to power the receiver, charge the detachable batteries, and use an external power source.
Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned on, the receiver’s
channels initialize and begin tracking all visible satellites at any time and location.

To turn off the receiver, press and hold the power button for more than three and less than 10 seconds (release the power button
when the BATT LED blinks solid red). This delay prevents the receiver from being turned off by mistake.

The receiver will draw a small amount of power from the batteries when it is turned off. If the receiver is
<//\/§S placed in storage for a long period, such as a few months, the batteries may become fully discharged. You will
need to use an external power supply or recharge the batteries before use.

Using Internal and External Power Sources

The receiver is powered by the detachable batteries or an external power source connected to the power port. If an external power
source is connected, the receiver draws power from it over the battery.
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You can connect the receiver to an external power source, such as a vehicle battery, with 6.7 to 18 VDC to operate the receiver.
See “Specifications” on page 69 for more information on external power source requirements to power the receiver and charge
the internal batteries.

Power input greater than 18 VDC could damage the receiver.
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Batteries

The battery compartment door provides access to the main battery. The receiver can also be powered using an external power
source.

Use one BDC70 rechargeable battery at a time to power the receiver.

The GRX2 also contains an internal backup battery, which maintains an internal RTC. The backup battery is automatically charged
from the main battery.
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Figure 9: GRX2 Battery and Charger

Inserting and Removing the Battery

® First, before removing the battery, always turn off power to the receiver. If the battery is removed while the power is
switched on, uncontrolled system shutdown will occur and file data may be lost as a result.

* Wheninserting or removing the battery, make sure that moisture, dust, or other foreign particles do not come in contact
with the inside of the instrument.

® Remove batteries from the surveying instrument or charger before placing into storage.
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® Store the battery in a dry room where the temperature is within the following ranges. For long-term storage, the battery g
should be charged at least once every six months. o
Table 3. Battery Storage Time 3

Storage Period Temperature Og

1 week or less -20°C to +50°C oQ

1 week to 1 month 20°C to +45°C S

1 month to 6 months -20°C to +40°C S

6 months to 1 year -20°C to +35°C {-E

® The BDC70 uses the latest advances in high density lithium-ion battery technology; however, like all batteries, it still
generates power using a chemical reaction and as a result, has a limited lifetime. Even when the battery is in storage and
not used for long periods, the battery capacity deteriorates with the passage of time. This may result in the operating
time of the battery shortening despite having been charged correctly. In this event, a new battery is required.
To Remove the Battery:

1. Turn over the GRX2.
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2. Push the buttons on both sides of the battery compartment cover, and lift the battery cover.

Press and Hold =~
Both Battery S
Compartment Buttons
(One on Each Side)

lamod 8uiSeueypy

Figure 10: Remove Battery Compartment Cover
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3. Slide the battery to the right, and separate the battery from the connector.

O

Slide Battery /)
to the Right to » — —
Remove E "“I =
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Figure 11: Remove Battery

4. Lift up the battery, and remove it from the receiver.

Only use a GRX2 battery with this receiver. Using an incorrect battery type may cause the battery to explode
and damage the receiver.
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To insert the battery:

1. Remove the battery cover.
2. Gently slide the bottom of the battery along the battery guides until it snaps into place (Figure 12 on

page 4-30).

lamod 8uiSeueypy

Slide Battery
to the Left to
Lock in Place

Figure 12: Remove Battery Compartment Cover
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Charging the Batteries

When the battery charge is low, the Available Power Bar changes from solid green to yellow to red and then blinking red,
depending on the remaining charge (see “Available Power Bar” on page 20). When the receiver is connected to an external
power source, the battery does not charge and becomes disabled from supplying power to the receiver.

To charge the battery, use the supplied charger. It takes approximately 4 hours to completely charge one battery and 8
hours to completely charge two batteries. The Li-lon batteries used in the battery packs should run at no less than 80%
capacity after 500 charging cycles. You do not need to drain the batteries before recharging.
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The batteries are shipped from the factory with a partial charge. For maximum operating time, fully charge the

g
= batteries before using the receiver.

To charge the batteries:

1. Connect the power cable to the charger and plug the charger into the wall outlet.
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2. Mount the battery in the charger by matching the grooves on the battery with the guides on the charger.

lamod 8uiSeueypy

Charging LEDs

Slot 2

Figure 13: Insert Battery onto Charger

3.  When charging begins, the lamp light blinks.
4. The lamp light is solid when charging is complete.
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5. Remove the battery and unplug the charger.

1anod 3uideuepy

Figure 14: Remove Battery

Slots 1 and 2: The charger starts charging the battery mounted first. If two batteries are placed in the charger,
the battery in slot 1 is charged first, and then the battery in slot 2.

Charging lamp: The charging lamp is off when the charger is outside the charging temperature range or when
the battery is mounted incorrectly. If the lamp is still off after the charger falls within its charging temperature
range and the battery is mounted again, contact a local dealer.
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-~ Charging time per battery (at 25°C) is about 4 hours (Charging can take longer when temperatures are either
= especially high or low.)

Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut down and
automatically save recorded files. To avoid disruptions, check the Available Power Bar on the display panel for the battery charge
status. See “Available Power Bar” on page 20 for more information.
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If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-activated.
To restore power to your receiver and turn it back on, do one or all of the following:

® Recharge the batteries.

* Make sure the power/serial cable is securely connected to the receiver’s port. Align the keyways (indicated with a red
dot) when connecting the power/serial cable to the receiver port.

® Connect the receiver to a different power source.

Power supplied to the receiver should match the specifications provided by Sokkia on the product. Failure to
o’ comply with these specifications may damage the receiver.
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Configuring the Receiver

Viewing Receiver Information

The section describes receiver options, and how to load a new Option Authorization File (OAF), update firmware, and perform a
factory reset. To do this, you will need to use the Sokkia Receiver Utility (SRU) software that was supplied on the SRU CD. For
information about installing the software, see the Sokkia Receiver Utility (SRU) Reference Manual.

In the Sokkia Receiver Utility (SRU), the Receiver Info window displays basic receiver information, such as hardware and firmware
versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open SRU.

In SRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

In the SRU main window, click the Information icon. The Receiver Info window (Figure 15) appears.

ok wNeE
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= Receiver Info

MName Value i oq
i Model GRXZ E
@ 1d O01LZUN2QLE —"
@ Serial Number GRx2 =)
@ Board Version BX10 0Q
¥ Firmware Version 4.0V Jun,29,2012 bs -+
@ Hardware Version 205 E =5
¥ Vendor Topcon ()
% CPU Freq., MHz 235 A
BERAM Size, KB 16,384

=IFlash Memory Total, MB 3,839
=IFlash Memory Available, MB 2,046
=IFlash Memory Free, MB 2,042
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Figure 15: SRU - Receiver Info
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains the following
two files:

®* Main board firmware
® GNSS firmware

® Radio firmware

To upload GNSS and radio firmware files to the receiver:

1. Connect the receiver to a computer using the serial cable.

2. To connect to the receiver in SRU:
a. Click Device » Application Mode » Receiver Managing.
b. Click Device » Connect.

c. Inthe Connection Parameters window (Figure 16), select Serial Port and the port name, and then click
Connect.

Loading New Firmware P/N: 1001826-01
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Figure 16: Connection Parameters Window

3. Click the Firmware z icon in the SRU main window. The Upload Firmware window (Figure 17) displays. This
window enables youht“o upload firmware files to the connected receiver.

4. Make sure Receiver is selected in the Device field.

5. (Recommended) Select Soft Break as the Capture Method.

6. Browse for and select the receiver board’s RAM and Flash files (Figure 17).
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Loader:  D:\ramimage.ldr

Image: | D:\nain.ldp

Capture Method
[softBreak
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Figure 17: Upload Firmware Window

7. Click Start to upload the selected files.
8. Click OK to continue uploading new firmware to the receiver (see Figure 18).
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r~Firmware : 8
RAM Image (.Idr): I C:\oem1_3_gplyamimage.ldr [ | o%
Main Flash (.Idp): | C:loem1_3_6p1imain.ldp = | S_r
—Capture Method (D
ISo& Break LI m
@ The firmware has successfully been uploaded. )
0
0}
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Figure 18: Finishing Firmware Upload

To load the main board firmware file to the receiver:

1. Perform a factory reset on the receiver. See “Performing a Factory Reset (Clearing the NVRAM)” on page 45.
Remove the storage card from the receiver. See “To install/remove the SD/SDHC card:” on page 56.

On the storage card, create a “Firmware” folder, and copy the acpu.shc file into the folder.

Insert the storage card back into the receiver.

vk wnn

Power on the receiver. The receiver will power up 20 to 30 seconds slower than normal. The |0]|0| LED begins to
flash, indicating the firmware is uploading.
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6. Reset the receiver again to return it to its original factory settings.

7. Use the Sokkia Receiver Utiility (SRU) to ensure the firmware was uploaded successfully. See “Loading New
Firmware” on page 37.

About the OAF

Sokkia issues an Option Authorization File (OAF) to enable the specific options that you purchased. Sokkia’s OAF system allows
you to customize and configure the receiver according to your particular needs, therefore purchasing only the options you
require.

The GRX2 receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are several upgrade
options available with the receiver that can extend the receiver’s functionality to better suit your job requirement. Examples of
upgrade options are listed below:

® GPS + GLONASS dual frequency static operation

* Radio-based RTK operation

* Network RTK operation

® RTK and update rate up to 20 Hz (10 Hz standard)
Contact your Sokkia dealer or a representative for a complete listing of available options and pricing information.

Loading New Firmware P/N: 1001826-01
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Checking the Receiver’'s OAF

To use SRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open SRU. See the Sokkia Receiver Utility (SRU) Reference Manual for more
information about connecting the receiver to a computer.

2. InSRU, connect to the receiver.

3. Click the Options T_ icon in the main window. The Receiver Options window (Figure 19) displays, so you can view
the current authorization options and upload new ones.

Receiver Options | = | E &J
Option Name Current Purchased Leased Exp. Date -
Elers Yes Yes Yes /242011
2] Glonass Yes Yes Yes 9/242011 E
A Yes Yes Yes 9/24/2011
Bl Yes Mo Yes 12/31/2011
Cinderella Yes Yes Yes 9/242011
Position Update Rate, Hz 100 20 100 12/31/2011
Raw Data Update Rate, Hz 100 20 100 12/31/2011
Code Differential Base Yes Mo Yes 9/242011
Code Differential Rover Yes Mo Yes 9/242011
RTK Base Yes No Yes 9/24/2011
RTK Rover, Hz 100 Disabled 100 9/24/2011
Memury, MB Mot supported a 1,024 9/242011
Co-op Tracking ‘fes Mo ‘fes 9/24/2011
1-PPS Timing Signal Double Double Double 9/24/2011
Event Markers Double Mo Double 9/242011
In-Band Int. Rejection Mot supported Disabled Enabled Outside USA 9/24/2011
Multipath Reduction Yes Yes 9/24/2011 =

Refresh | Upload OAF ‘ Save to File

Figure 19: Receiver Options
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Loading an OAF

Sokkia dealers provide customers with OAF files. For any OAF related questions, e-mail Sokkia at options@Sokkia.com and
include the receiver’s ID and serial number. To obtain these numbers, see “Viewing Receiver Information” on page 35.

To load a new OAF:

1. Follow the steps in “Checking the Receiver’s OAF” on page 42.
2. Click Upload OAF on the bottom of the Receiver Options window (see Figure 19).
3. Navigate to the location of the new Option Authorization File (Figure 20).

& Oper e
@-v-?‘ » Computer ¢ OS(C:) » GRX2 v|‘y‘| Search 2|
Organize »  Newfolder B - O @

. GNSS Internet Radio *  Name : O

. GSR2700 Config Teol
MAGNET

. Mission Planning Tool

. ModemTPS

. NMEA Reader
NTRIP Client

. PC-CDU

. Pocket3D

| Quality Center
ReqPro

. RTKLib -~ 4 m 3

File name: _UNIVERSAL _tpo ~ | Options Files (*.tpo) v
> —— e —
Coe_D[ s
S ——

Figure 20: Load OAF

|| _UNIVERSAL_tpo [3

m
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4. Select the appropriate file, and click Open (Figure 20).
Sokkia’s SRU initially checks to see if the selected file is compatible with the currently connected receiver. If you

chose a file not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID and
disables the Upload the File to the Receiver button.

r r
= Upload OAF [E=TE ) & Upload OAF E=E)

C:\GRX2 \ UNIVERSAL tpo =) C:\Receiver OAF\Universal.tpo

Property Value = Property Value

Blseriaive  na i 1

Elreceiver _UNIVERSAL_ [ [Freceiverid 1037GvE30FK

Elmodel KXKXXKXX-KX Universal Legacy = [ TT-100500-% M

Blchecksum  c19e = [Echedsum 5157

=Dealar Topcon Positioning Systems, Inc. =Dealer Topcon Positioning Systems, Inc.
=Email T ey - EEma\I 7 ———— g~

[Pl submitrtime 2012-06-20 21:01:19 [ElsubmitTime 2011-12-21 17:30:20

Hlcipher Digest [Elcipher Digest

r = [Elcomments  MMI test files

4 r
[ Upload the File to the Receiver ] [ Upload the File to the Receiver ]‘

Figure 21: OAF Compatibility Check
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5. Press Upload the File to the Receiver (Figure 21) to start loading the file.
If an OAF file is uploaded to the receiver, SRU will offer to reset the receiver to put new authorization options into
operation (Figure 22).

TRU l J

fo- The changes will take effect after reset, Reset the receiver?

Figure 22: Reset the Receiver

6. Click Yes.
Performing a Factory Reset (Clearing the NVRAM)

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data
and receiver position. The NVRAM also keeps the current receiver’s settings, such as active antenna input, elevation masks and
recording interval, and information about the receiver’s internal file system. Clearing the receiver’s NVRAM restores the
receiver’s factory default settings.

Although clearing the NVRAM is not recommended as a common practice, there are times when it can eliminate communication
or tracking problems.

After clearing the NVRAM, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps information
about the receiver file system.

Performing a Factory Reset (Clearing the NVRAM) P/N: 1001826-01
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You can also use SRU to clear the NVRAM:

1. Connect the receiver to a computer, and open SRU. See the Sokkia Receiver Utility (SRU) Reference Manual for more
information about connecting the receiver to a computer.

2. In SRU, connect to the receiver.

3. Click the Tools icon £ in the main window.

The Tools window appears, enabling you to reset the receiver and clear the NVRAM.

i
&l

==

4 Tools

Reset Receiver

9

\‘/ After clearing NVRAM, the receiver will require some time to re-collect data needed ko track sateliites, Continue?

Factory Reset

e

Reset Parameters

Reset RTK

Figure 23: Tools Dialog Box

4. Click Reset Receiver, and click Yes to continue.

Performing a Factory Reset (Clearing the NVRAM) P/N: 1001826-01
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POWERUP Script Requirements

After turning on the receiver, the POWERUP script executes when the receiver obtains valid position coordinates and the
following requirements are satisfied.

® The POWERUP script has been installed to receiver.
* The POWERUP script function setting is ON.

® The receiver is not starting by using the timer.

* There is no enabled job/session.

Installing the POWERUP Script

To install the POWERUP script onto the GRX2 receiver:

1.

2.
3.
4

P
gz

Copy the POWERUP script file “powerup.gcs” to the “POWERUP” folder on the SD card.
Insert the SD card into GRX2 receiver.
Perform a Factory Reset on the GRX2.
Once the installation is successful, the “powerup.gcs” file is removed from the SD card.

If the file attribution is Read only, the file will not be not removed.
If there is the existing POWERUP script on the GRX2, it will be overwritten by the new script file.

POWERUP Script Requirements P/N: 1001826-01 a7



Uninstalling the POWERUP script

The POWERUP script can be uninstalled by using either of the following two methods.
Method 1: Install an empty (no script) “powerup.gcs” file.

Method 2: Send the command “set,/ext/powerup/clear,y” using the Terminal feature of SRU.

Editing the POWERUP Script

It is not possible to edit the existing POWERUP script in receiver directly. Install (overwrite) the new POWERUP script after
modifying the script using SRU.

Enabling the POWERUP Script

It is necessary to enable the POWERUP script function in order to allow the HiPer Il to execute the POWERUP script at every
startup of the receiver. Enable the POWERUP script by using any of the following three methods.

Method 1: Send the terminal command “set,/ext/powerup/mode,on”
Method 2: Perform a Factory Reset of the receiver.

Method 3: Enable using the SRU software.
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Disabling POWERUP Script

Disable the POWERUP script by using either of the following two methods.
Method 1: Send the terminal command “set,/ext/powerup/mode,off”

Method 2: Disable by using the SRU software.
Managing the Radio Modem

The Sokkia Receiver Utility (SRU) software supports the configuration of all radio modems that are embedded in Sokkia
receivers.

To configure the radio modem, have the following ready:

® A computer running a Windows 2000 operating system or newer
® SRU installed on the computer
* Aserial cable or Bluetooth-capable computer

For instructions on configuring radio modems, see the SRU Reference Manual. Both are supplied on the GRX2 Manual CD and
sokkia.com.

Managing the Radio Modem P/N: 1001826-01
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Field System Setup

This chapter describes the field setup of your new GRX2, so it is ready for use as a Base, RTK or network Rover, or static data
collection.

wm—— GRX2 Receiver
iy

y

External Modem

10cm Spacer Antenna

Horizonal Spacer

Tribrach Adapter
(Precision)

Universal Tribrach

Figure 24: Equipment and Setup
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3. Level the tripod and measure the height of the receiver
from the ground using the tape measure. See
“Measuring Antenna Height” on page 53.

4. Connect the external radio antenna to the antenna
port for RTK setup.

5. Press the power button to turn on the receiver. The
integrated wireless device in the receiver turns on
when the receiver is powered.

6. Connect the receiver to the Bluetooth-enabled data
collector, running Topcon Field software, to configure
and start the base GRX2 receiver.

7. View the LED display panel for the receiver’s current
status. See also “Display Panel Operations” on page 18.

Setting Up the Base Receiver T

1. Mountthe receiver on a tripod with a tribrach, tribrach Q.

adapter, and prism spacer, as shown in the picture on o ——— g’

the right. SOKKIA ol

2. Position the base system (from step 1) over a known g
point.

n

M
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O
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Setting Up the Rover Receiver

1. Mount the receiver on the rover pole, as shown in the
picture on the right.

2. Attach a Sokkia controller to the pole using a mounting
bracket.

3. If you are not using a fixed height rover pole, measure
the height of the receiver from the ground. See
“Measuring Antenna Height” on page 53.

4. Connect the external radio antenna to the antenna
port for RTK setup.

5. Press the power button to turn on the receiver. The
integrated wireless device in the receiver turns on
when the receiver is powered.

6. Connect the receiver to the Bluetooth-enabled data
collector, running Sokkia Field software, to configure
the GRX2 as a rover receiver.

7. View the LED display panel for the receiver’s current
status. See also “Display Panel Operations” on
page 18.
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center.

89mm
To determine the coordinates of the station marker, specify the
following:

® Measured height of the antenna above the station marker SHMM
* Method of measuring the antenna height T —1
* Model of the antenna/receiver used
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Any necessary antenna phase center adjustments, based on the
antenna model, is automatically applied. This adjustment, when
combined with accurately measured height and measurement
methods, allows for correctly computed reference marker
coordinates.

To accurately measure the antenna height:

1. Measure the antenna height above the control point or
marker, either the slant height or the vertical height.
You may either measure the vertical height to the Antenna
Reference Point (ARP) located at the bottom of the receiver at
the base of the mounting threads, or measure the slant
height to the Slant Height Measurement Mark (SHMM) on the
side of the receiver, as shown on the right.

2. Record the antenna height, points name, and start time in the
field notes.
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Collecting Data

This chapter provides general information about recording data, downloading it, and managing files.

Setting Recording Parameters

The Sokkia Receiver Utility (SRU) software enables you to set logging parameters, such as logging rate and types of messages, in
which to record data. This software and the SRU Reference Manual is supplied on the GRX2 CD. See the SRU Reference Manual for
more information. The GRX2 receiver is compatible with any Sokkia field software for configuration and recording raw data.

Logging Rates

The receiver logs data on the SD/SDHC card that is inserted into the memory card slot. The amount of file space depends on the
size of the memory card being used. The GRX2 receiver can support memory cards of up to 32 GB capacity®. The amount of

memory used to log data depends on the logging rate. For more information about setting logging rate parameters, see the SRU
Reference Manual.

1. The maximum number of files is limited to 512. The receiver may take up to 50 seconds to check larger (8/16/32GB) SDHC cards when inserted into
the receiver. For 2 and 4 GB SD/SDHC cards, this external card check is completed instantly, allowing you to use it without any delay.
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Using SD/SDHC Cards

The SD/SDHC card slots reside under the battery on the inside edge of the battery recess. The data that resides on the SD/SDHC
card can be accessed by removing the card and using an external SD/SDHC card reader or by using Sokkia software to download
the data from the card via GRX2's serial port or Bluetooth connection. A secure digital card suitable for industrial use can be
purchased from a local Sokkia dealer. The SD/SDHC card is available in FAT16 or FAT32 format so that the removable SD/SDHC
card is suitable for copying data files directly to a computer. For recommendations about SD/SDHC cards, see “SD/SDHC Card
Recommendations” on page 88.
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SIM Card Slot

SD/SDHC Card Slot
Figure 25: GRX2 Card Slot Example
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To install/remove the SD/SDHC card:

Logging Rates

Ensure the receiver is turned off.
Remove the battery. See “Inserting and Removing the Battery” on page 26.

Carefully push the SD/SDHC card, label side down, into the SD/SDHC card slot (Figure 25) until it locks into place.
Or, push the card once to remove it.
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Figure 26: Install SD/SDHC Card

Do not remove the card if the receiver is powered on. Damage to data may result from improper removal of
the card.
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Once the receiver is turned on, the receiver board will detect the SD/SDHC card, and it will be ready to use as needed.

Recording Data

You can log raw GNSS data to the receiver’s memory card and use the Sokkia Receiver Utility (SRU) or MAGNET Office™ software
to download the files to a computer.

To start or stop recording data to the receiver, you can use the LED display panel or SRU.

1.
2.

Press the Power button to turn on the receiver.

Wait for the STAT LED to indicate satellites are being tracked. The STAT LED blinks green for GPS satellites and amber
for GLONASS satellites. A short red blink indicates the receiver has not solved a position. Five or more satellites
provide optimal positioning.

Press the POWER button three times within two seconds to begin recording. You can also select File

Explorer » Logs » Start in SRU to begin recording data.

Make sure the REC light is blinking green. This indicates that a file has opened and data collection has started. The
REC LED blinks each time data is saved to memory.

When you have finished recording, press the POWER button three times, and make sure the REC LED is dark. You can
also select File Explorer » Logs » Stop in SRU to end data recording.

To turn off the receiver, press and hold the POWER button for 3 to 10 seconds until all LEDs turn dark and the BAT
LED is solid red.

@@ You can also log data using MAGNET Field software.

Recording Data
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Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the receiver’s memory and
automatically given a name and a *.tps file extension. You can then transfer a file of collected data to a computer with file
managing software, such as the Sokkia Receiver Utility (SRU), which is supplied on the GPS+ Software CD. This program allows
you to use an automatic naming feature, enter file names, and delete files as necessary. For more information, see the SRU

Reference Manual supplied on the GRX2 CD.
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Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or backup.
Downloading and deleting files prepares the memory card for the next survey. (When the memory card is full, the receiver stops
logging data, and the REC LED turns dark/off, indicating an error condition. Existing data is not overwritten.)

There are three options for deleting raw data files from the receiver:

® Delete all of the files using the LED display panel (i.e. hold the power button for 20 to 25 seconds). This erases all of the
files in the receivers internal memory.

® Use aserial or Bluetooth connection to download the files to a computer/controller. In the Sokkia Receiver Utility (SRU),
you can select the files you want to delete from the receiver. See the SRU Reference Manual for more information.

* Remove the memory card and insert it into the memory card slot of a computer/controller.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the hardware.

Check This First!

Before contacting your local dealer or Sokkia Support, check the following:

® Check all external receiver connections carefully to ensure correct and secure connections. Double check for worn or
defective cables.

® Check the receiver’s batteries for a full charge.

® Check the power source for incorrectly connected cables, and ensure the power source is valid. See “Specifications” on
page 57 for external power requirements.

® Check the software. Make sure the most current software version is downloaded onto the computer and the most current
firmware is loaded into the receiver. Check the Sokkia website for the latest updates.

® Check Sokkia Technical Support (www.Sokkiasupport.com) or Sokkia.com for the latest updates.
Then, try the following:

* Power on and off the receiver by pressing the Power button or by using SRU (Tools » Reset receiver).
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® Restore default settings by pressing the Power button for 10 to 15 seconds or using SRU (Tools » Clear NVRAM). This
restores the receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This
action does not delete data files from the receiver memory.

® Erase all files by pressing the Power button for 20 to 25 seconds or by using File Explorer » Delete All Files in SRU. This
will delete all files stored in the receiver’s non-removable memory card.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
® The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 22.
* If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power up,
contact your local dealer or Sokkia Support for advice.

Powering Problems P/N: 1001826-01 60
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller
Cable specific problems:

® The cable is not properly plugged in.
— Unplug the cable, then securely and properly reconnect it to the receiver.

-
0
c
A
0
w0
>
0
0
=d
5
¢a

® The cable is damaged.
— Use an undamaged cable. Contact a dealer to replace the cable.
Generic problems:

® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open SRU (see “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manual).

b. Click Receiver Settings » Ports.

c. Change the Input Mode for the port used for connection to cmd.

The receiver does not lock on to satellites for a long period of time

* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track satellites).

— Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the Sokkia Support website (www.SokkiaSupport.com) for details.
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— Refer to the “Receiver Managing” chapter of the Sokkia Receiver Utility (SRU) Reference Manual for a detailed
description of options.

The receiver tracks too few satellites
® The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled.

a. Connect the receiver to a computer and open SRU [see “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manuall.
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b. In SRU, connect to the receiver.
c.  Onthe SRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A code
multipath reduction check box is selected.
®* Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK solutions
® Incorrect Base coordinates entered.
— Specify the correct coordinates for the Base station using SRU or another suitable field data collection software.
® The corresponding receiver options may be disabled or expired.

— Order a new OAF with the required options activated to enable or extend validity of the corresponding receiver
options.

— Refer to the Sokkia Receiver Utility (SRU) Reference Manual for a detailed description of options.

® There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track at least
five common satellites.
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— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on the SRU
main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
* Adiscrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:

a. Connect the receiver to a computer and open SRU [see “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manual].
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b. In SRU, connect to the receiver.
c.  Onthe SRU main window, choose Receiver Settings » Ports.
d. Double-click on the port to be configured and make sure the input mode of the Rover matches the format
of the Base output mode (i.e. RTCM3).
® Poor satellite geometry (PDOP/GDOP values are too high).
— Ensure the elevation mask is less than 15 degrees.
— Increase the PDOP threshold. To do this, on the SRU main window, choose Receiver Settings » Tracking » Obs.
— Conduct the survey during a time period when satellite visibility and geometry is better (if possible).
® The modem battery is low.

* The specified baud rate is incompatible with the baud rates the modem supports. The baud rate is the rate at which the
receiver transmits differential messages to the modem and vice versa.

— Change the modem’s baud rate.
® The Base and Rover modems use different radio link parameters.

— Configure the Base and Rover radio modems according to the procedures listed in the SRU Reference Manual.
® The distance between the Base and Rover is too far.

— Close the distance between the Base and Rover.
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— Use repeaters to increase radio coverage.
® The elevation mask is above 15 degrees.
— Lower the elevation mask. To do this, on the SRU main window, choose Receiver Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
® There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).
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The receiver does not start logging data
® The SD/SDHC card is not properly inserted.
® The receiver memory option is disabled or expired.
— Make sure the memory option is enabled. For details, see the Sokkia Receiver Utility (SRU) Reference Manual.
® The receiver’s memory card does not have free space.

— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files” on
page 46.

—The file system is not initialized. Initialize the File System on the SD card using SRU. To do this, on the SRU main
window, choose File Explorer » Initialize File System.
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

SRU error message: Can’t find receiver

® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.

—You can also turn on power to Bluetooth using SRU. To do this, on the SRU main window, choose Receiver
Settings » Bluetooth.

* Thereis interference.
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— Move the receiver, controller, or computer to an unobstructed location.
® The receiver is too far away.

— Move the devices closer together.
® The receiver is already connected via Bluetooth to another device.

— Disconnect the receiver from the other controller or computer.
® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open SRU [see “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manual].
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b. Click Configuration » Receiver » Ports.

c. Change the Input Mode for the Bluetooth serial port used for connection to cmd.

This is the most common cause for this error message. Use SRU to double check the settings for the
o’ connection port.
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SRU error message: Open COM# port failed: Access is denied
® Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

® The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the optional power cable is correctly attached to the port if one is being used.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.

Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

® Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
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® Bluetooth module settings may have changed.

a. If the settings are changed for the Bluetooth module, remove it from the list of discovered Bluetooth
devices using the Bluetooth manager program (supplied with the device used to manage the receiver).

b. Repeat the search.
SRU Problems

The following is the most commonly encountered SRU problem.
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SRU cannot connect to the receiver
® The receiver is turned off.
— Ensure the receiver has power and is turned on.
* |f using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
® |f using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
* |f using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

— Make sure the computer and receiver use the correct ports for communication. For the GRX2 receiver, this is
Bluetooth serial port A (btsp\a).
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Cleaning and Storing the Receiver

® Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
® Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support
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If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Sokkia Support. For contact
information, see “Getting Technical Support” on page 7.
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Specifications

This chapter provides specifications for the GRX2 and its internal components. This list of recommendations is based on testing
results available to date and should not be considered a comprehensive list. The receiver is capable of working with SD/SDHC cards
with a storage capacity of up to 32GB.

General Details

Table 4. Receiver General Specifications

Physical

Enclosure Magnesium alloy

Color Sokkia gray and blue (bumper)
Dimensions 184.0mm X 95.0mm (diameter x Height)
Weight 1.00kg (without battery and radio)
Antenna Internal micro center

Battery Built-in, detachable/replaceable
Controller External

Mounting 5/8-11, quick release
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Table 4. Receiver General Specifications (Continued)

Seals Silicone

Keys One key:
Power- On/Off, multi-function

LEDs 22 LEDs

Receiver Health
Scheduler Status
Available Power Bar
Battery Status
Satellite Tracking Bar
Position Status
Memory Capacity Bar
File Status

Wireless Status
Radio Status

Serial Port Status
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Environment

Operating -20 to +65°C (Battery) / -40 to +65°C (Ext.) / -20 to +55 (w/ UHF modem module)
temperature

Storage temperature | -45°C to +70°C

Humidity 100% condensing

Water/Dust-proof [P67 with all connector caps closed.
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Table 4. Receiver General Specifications (Continued)

Power

Built in battery

BDC70 Li-ion 5.2Ah (Typical) / 7.2VDC

Battery weight 195¢g
Battery charging 4 hours
time

Operating time

Over 7.5 hours (20C / static data logging / w BT)

External power 1 port
Input voltage 6.7 to 18 VDC
Consumption 4W (w/o UHF modem)

Battery charge

Use CDC68

On-board Backup battery for NVRAM and RTC storage;
Operation for approximately 100 days.

/0

Communication Bluetooth and (Serial) RS-232C

Ports

General Details
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Table 4. Receiver General Specifications (Continued)

Port specifications COM1: 4,800 to 115,200 bps (RS Level)
115,200 bps (default)
Bluetooth: 115,200 bps (SPP/Single Channel mode)
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Modem Antenna BNC

NMEA

NMEA version Ver.2.1,2.2,2.3,3.0

Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC, VTG, ZDA, ROT, GMP
Output interval Up to 20Hz

DGPS

Correction format RTCM SC104 Ver 2.1,2.2,2.3,3.0, 3.1

RTCM message 1, 3,9, 31, 32, 34; user selectable
type
Process interval Up to 20Hz

Output interval for Up to 20Hz
RTCM correction
data

Elevation mask 0 to 90 degrees (independent of data logging)
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Table 4. Receiver General Specifications (Continued)

RTK

Correction format®

CMR/CMR+, RTCM SC104 Ver 2.2,2.3,3.0 or 3.1

RTCM message
type

User selectable

Ambiguity initialize

OTF (L1, L1/L2)

Baseline Length

Up to 50km

Initialize time

> 15 seconds, typical

Output interval for Up to 20Hz
CMR/RTCM
Elevation 0 to 90 degrees (independent of data logging)

Solution mode

Delay (synchronization)
Extrapolation (not synchronized)

Process interval

Up to 20Hz

General Details
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Table 4. Receiver General Specifications (Continued)

Survey Accuracy®

Static

L1 only:
H: 3mm + 0.8 ppm xD
V:4mm + 1 ppm xD
L1 +L2:
H: 3mm + 0.5 ppm xD
V: Smm + 0.5 ppm xD

Fast Static

L1+L2:
H: 3mm+0.5 ppm xD
V: 5mm+0.5 ppm xD

Kinematic L1+L2:
H: 10mm+1 ppm xD
V: 15mm+1 ppm xD
RTK L1/L1 +L2:
H: 10mm + 1 ppm xD
V: 15mm + 1 ppm xD
DGPS Post processing/RTCM:
Typically less than 0.5m
Cold start <60 sec
Warm start <35 sec (typical)
Reacquisition <lsec

General Details
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a. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and performance cannot be guaranteed.
Use of industry standard RTCM 3.x is always recommended for optimal performance.

b. RMS Values: Accuracy depends on the number of satellites used, obstructions, satellite geometry (DOP), occupation time,
multipath effects, atmospheric conditions, baseline length, survey procedures, and data quality.

General Details

Performance specifications assume a minimum of 6 GPS satellites above 15 degrees in elevation and
adherence to the procedures recommended in this manual.

In areas of high multipath, during periods of large PDOP, and during periods of increased ionospheric
activity, performance may degrade.

Use robust checking procedures in areas of extreme multipath or under dense foliage.

P/N: 1001826-01
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GPS Board Details Y
0

Table 5. GPS Board Specifications gh

Receiver Type (set by activating the proper OAF) 8
~+

Internal GNSS G: GPS L1 o]
board: GRX2 GD: GPS L1/L.2 a

GG:GPS/GLONASS L1
GGD: GPS/GLONASS L1/1L.2

Hardware type: without internal radio/modem

country/region/pur- | with Digital UHF II

pose dependent with Digital UHF II + HSPA
with Digital UHF II + CDMA
with FHI915
with FH915+HSPA

Tracking Specifications

Standard Channels 226 channels®; Vanguard™ ASIC with patented Universal Tracking Channel Technology
GPS and GLONASS, WAAS/EGNOS/MSAS/QZSS

Tracked Signals GPS: L1, L1 C/A, L2, L2P(Y), L2C code and carrier
GLONASS: L1P, L1 C/A, L2 C/A, L2P code and carrier

Tracking Functions

Multi-path Code and Carrier
reduction
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Table 5. GPS Board Specifications (Continued)

PLL/DLL/QLL

Bandwidth, order, adjustable

Smoothing interval

Code and Carrier

WAAS/EGNOS/
MSAS

Optional

Data Features

Formats

TPS, NMEA, RTCM, CMR/CMR+

Features

Up to 20 Hz update rate for real time position and raw data (code and carrier)
10cm code phase and 0.1mm carrier phase precision

RTCM SC104 version 2.1, 2.2, 2.3, 3.0, and 3.1 I/O

Multiple Base RTCM

Geoid and Magnetic Variation models

Different DATUMs support

Output of grid coordinates

CMR and CMR+ support

Memory

Internal Memory

SD/SDHC card, removable

Capacity

Dependent on capacity of the installed SD/SDHC card

Logging Interval

0.05 to 86,400 seconds, depending on purchased options

a. Includes two dedicated channels for L-Band signal tracking. The receiver does not support L-Band signal tracking.

GPS Board Details
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Bluetooth Module Details

Table 6. Bluetooth Module Specifications
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Range Up to 10 m (indoor), up to S0m (outdoor)
Type Class 1?
Service classes Miscellaneous

Supported profiles SPP

Frequency Country | North America and Europe
Code

a. For the receiver’s Class 1 Bluetooth functionality to work properly, the connected device must also support Class 1 Bluetooth.
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Internal Digital UHF Il Modem General Specifications

For complete details regarding the digital UHF II modem, refer to the Sokkia Radio Guide Reference Manual (p/n:
1001598-01).
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Table 7. GRX2 Digital UHF Il Modem General Specifications

Parameter Specification

Operating frequency range® UHF 400 - 470 MHz

Modulation techniques GMSK and 4-Level FSK (4FSK)
Protocols™© Satel 4FSK

PDL GMSK

PDL 4FSK

TrimTalk GMSK

Occupied bandwidth? (channel spacing) |25 kHz, 20 kHz or 12.5 kHz

Data transmission rate at 25 kHz 9600 bps GMSK
Channel Spacing 19200 bps  4FSKY
Data transmission rate at 20 kHz 4800 bps  GMSK
Channel Spacing 9600 bps  4FSK
Data transmission rate at 12.5 kHz 4800bps  GMSKY
Channel Spacing 9600 bps ~ 4FSKY
Data speed of serial interface Max 115200 bps
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Table 7. GRX2 Digital UHF Il Modem General Specifications (Continued) wn

O

Parameter Specification 2

Forward Error Correction Yes =

Scrambling Yes 8

~+

Communication mode Half-Duplex o

Operation modes Transmitter a
Receiver
Repeater

a. Dependent on the country and region, and mode (base/rover) of operation.

b. Use of PDL and Satel 4FSK protocols is recommended in applications where possible. Note that a minimum baud rate of 9600 bps
is recommended for all RTK operations. Compatibility with TrimTalk is subject to some restrictions.

c. The data transmission configurations indicated (protocol and channel spacing) are the only protocols that provide compliance
with UHF Narrowbanding restrictions that are effective as of January 1, 2013 in the US and Canada. For more information,
please see http://transition.fcc.gov/pshs/public-safety-spectrum/narrowbanding-fag.html for details. Similar restrictions are
also in place in other global markets. Please contact your Dealer or local government radio authority to ensure you understand
local compliance obligations.
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Optional Cellular Module Details

This section describes the specifications of the cellular modules offered with the GRX2 receiver.

CDMA Module Specifications

Table 8. Cellular Module Specifications

General (Dual Band CDMA 1xRTT Module)

Supported bands? CDMA 800/1900 MHz

TX power 800 MHz — Class 3 (24 dBm)
1900 MHz — Class 2 (24 dBm)

Data 1x/QNC/HSPD

CSD, Max BR 14.4 Kbps

AT command Set N/A

Regulatory and CDGl1, CDG2
approvals FCC, IC, CCC
EMC
QS9000 manufacturing
RoHS/WEEE

Optional Cellular Module Details P/N: 1001826-01
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a. Sokkia GNSS receivers equipped with integrated C24 wireless modules are authorized to operate in the US only on the Verizon™

wireless network.

HSPA Module Specifications

Table 9. Cellular Module Specifications

General (3.5G Wireless Module Quad-band GSM and UMTS/HSPA)

Supported bands GSM 850/900/1800/1900 MHz
UMTS/HSPA 850/1900/2100 MHz

TX power UMTS/HSPA - Class 3 (0.25 Watt)

GSM 850/900 MHz — Class 4 (2 Watt)

GSM 1800/1900 MHz — Class 1 (1 Watt)
EDGE 850/900 MHz — Class E2 (0.5 Watt)
EDGE 1800/1900 MHz — Class E2 (0.4 Watt)

Data UMTS/HSDPA/HSUPA 3GPP, Release 6

GSM/GPRS 3GPP, Release 9

Max uplink 5.76 Mbps, max downlink 7.2 Mbps

EDGE, Multi-Slot class 12

CSD, Max BR 14.4 Kbps GSM, Max BR 14.4 Kbps UMTS

AT command Set GSM 07.05, 07.07

Optional Cellular Module Details P/N: 1001826-01
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Table 9. Cellular Module Specifications _%)
Regulatory and FCC, IC g
approvals ANATEL (Brazil) =
PTCRB o
R&TTE/CE =
GCF 6
RoHS/WEEE 3
ACMA ©n
BABT

Battery (BDC70) Specifications

Table 10. Battery Specifications

General

Nominal voltage 7.2V

Capacity 5.2Ah

Dimensions 38 (W) x 70 (D) x 40 (H) mm
Weight about about 195¢g
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Charger (CDC68) Specifications

Table 11. Charger Specifications

General

Input voltage:

AC100 to 240V

Charging time per

about 4 hours

temperature range:

battery (at 25°C): (Charging can take longer than the times stated above when temperatures are either especially high or
low.)
Charging 0°C to 40°C (32°F to 104°F)

Storage temperature | -20°C to 65°C (-4°F to 149°F)
range:

Size: 94 (W) X 102 (D) X 36 (H) mm
Weight: about 170g

Charger (CDC68) Specifications P/N: 1001826-01
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Connector Specifications

The receiver has 3 external connectors; one UHF/915+ radio modem or cellular antenna connector.

UHF Radio Modem Connector

Table 12. UHF Modem Connector Specifications

Modem Type Signal Type Dir Details

UHF BNC Modem I/O /0 RF/GSM output from
modem antenna

Connector Specifications P/N: 1001826-01
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Power Connector

Rimmed in red, the power connector (on the right) is a 5-pin
sealed receptacle. Table 13 gives power connector specifications.

Table 13. Power Connector Specifications
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Number Signal Name Dir Details @ @ @
1 Power_INP P 9 to 21 volts DC input @ ®)
2 Power_INP P 9 to 21 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 AUX_POWER P 9 to 21 volts DC input

Connector Specifications P/N: 1001826-01




C-RS232 Serial Cable Connector s
Rimmed in black, the serial C-RS232 connector (on the @ 8.,
right) is an 8-pin sealed receptacle. Table 14 gives the o
C-RS232 connector specifications. g a g_
Table 14. RS$232 Connector Specifications 9 @ @ §

Number Signal Name Dir Details Q @

1 - - Not used

2 RXD INPUT Receive data

3 TXD OUTPUT Transmit data

4 GND 1’0 Signal ground

5 GND /0 Signal ground

6 - - Not used

7 RTS OUTPUT Request to send

Connector Specifications P/N: 1001826-01 87




SD/SDHC Card Recommendations

Table 15 is a recommended list of SD/SDHC cards that were tested with the receiver. This list of recommendations is based on
testing results available to date and should not be considered a comprehensive list. The receiver is capable of working with

SD/SDHC cards with a storage capacity of up to 32GB.

Table 15. SD/SDHC Card Recommendations

Manufacturer Model Name Card Type Capacity Class Tem(?)g(ra::xirneg("C)
ATP AF2GSDI (Industrial Grade) SD 2GB - -40 to 85
Transcends TS2GSD801 (Industrial Grade) SD 2 GB - -40 to 85
Panasonic RP-SDP02G SD 2GB Class 4 -251t0 85
Panasonic RP-SDW04G SDHC 4GB Class 10 -25 to 85
FujiFilm SD-002G-C4A SD 2GB Class 4 -25 to 85
Sony SF-2N1 SD 2GB Class 4 -2510 85
Toshiba SD-E002G4 SD 2GB Class 4 -25t0 85
HagiwaraSys-com HPC-SD2GT4C SD 2 GB Class 4 0to 55

SD/SDHC Card Recommendations

P/N: 1001826-01
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Table 15. SD/SDHC Card Recommendations

n

0O

Manufacturer Model Name Card Type Capacit Class Operating 2
yp pacity Temperature (°C) =

Q)

Lexar LSD2GBAC SD 2GB - 0to 55 =
Buffalo RDDC-S2GC4 SD 2GB Class 4 0to 55 g
(V)]

2 GB or less SD cards can be formatted with FAT16 or FAT32 on Windows PC platform. For 4 GB SD cards, use FAT32
- ,@S formatting.
Z

Use of the listed SD/SDHC cards may cause inconsistent performance (raw data logging problem, unrecognized card,
etc.) when used with HiPer and GRX receivers:

® SanDisk Standard Series (Model Name: SDSDB-4096 and SDSDB-2048)

® SanDisk Ultra Series (Model Name: SDSDH-002G)

® Transcends (Model Name: TS4GSDHC6)

* Model BSD-2G4 from 1/0 data exhibit good performance if formatted in FAT16 format.

P/N: 1001826-01




Warranty

Sokkia positioning equipment are guaranteed against defective material and workmanship under normal use and application
consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original purchaser by Sokkia’s Authorized Dealers.?

During the warranty period, Sokkia will, at its option, repair or replace this product at no additional charge. Repair parts and
replacement products will be furnished on an exchange basis and will be either reconditioned or new. This limited warranty does
not include service to repair damage to the product resulting from an accident, disaster, misuses, abuse or modification of the
product.

Warranty service may be obtained from an authorized Sokkia warranty service dealer. If this product is delivered by mail, purchaser
agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping charges to the warranty service
location and to use the original shipping container or equivalent. A letter should accompany the package furnishing a description
of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Sokkia be liable for any damages or other
claim including any claim for lost profits, lost savings or other incidental or consequential damages arising out of the use of, or
inability to use, the product.

2. The warranty against defects in a Sokkia battery, charger, or cable is 90 days.

Warranty P/N: 1001826-01 90



Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the radio modem.

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances, angles and
depths, and recording such measurements). This product should never be used:

Without the user thoroughly understanding this manual.
After disabling safety systems or altering the product.
With unauthorized accessories.

Without proper safeguards at the survey site.

Contrary to applicable laws, rules, and regulations.

TPS receivers should never be used in dangerous environments. Use in rain or snow for a limited period is
permitted.

Safety Warnings

P/N: 1001826-01 91



Battery Pack Warnings

R ZEIED)

Never attempt to open the casing of the detachable batteries! Lithium-lon batteries can be dangerous if
mishandled!
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Do not incinerate or heat battery pack above 212 degrees fahrenheit (100 degrees celsius). Excessive heat can
cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the battery’s warranty.
® Do not attempt to open the battery pack or replace it.
® Do not disassemble the battery pack.
® Do not charge in conditions different than specified.
® Do not use other than the specified battery charger.
® Do not short circuit.
® Do not crush or modify.

Battery Pack Warnings P/N: 1001826-01




Receiver Warnings

Tampering with the receiver by the end users or non-factory authorized technicians will void the receiver’s

warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise

treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Receiver Warnings P/N: 1001826-01
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of RF energy that it deemed to
comply without maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with
at least 30cm and more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part 15 of the FCC rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.

Regulatory P/N: 1001826-01 94



® Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
® Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

A1oje|n3ay

Industry Canada Compliance

This equipment complies with IC radiation exposure limits set forth for uncontrolled equipment and meets RSS-102 of the IC
radio frequency (RF) exposure rules. This equipment has very low levels of RF energy that it deemed to comply without
maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with at least 30cm
and more between the radiator and person’s body (excluding extremities: hands, wrists, feet, and ankles).

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit
accepter tout brouilage radioélectrique subi, méme si le brouillage est susceptible d’en compromettre le fonctionnement.

IC RF Radiation Exposure Statement

When installing, locate or point this device away from the installer, so it does not emit RF field in excess of Health Canada’s limits
for the general population; Consult Safety Code 6 from Heath Canada’s website at www.hc-sc.gc.ca/rpb.

Industry Canada Compliance P/N: 1001826-01 95



IC Additional Statement with Detachable Antennas

This device (with UHFIl modem) has been designated to operate with the antennas listed below and have a maximum gain of
2.4dB. Antennas not included in this or having a gain greater than 2.4 dB are strictly prohibited for use with this device. The
required antenna impedance is 50 ohms.

GRX2 UHFII 2.4dBi whip antenna

A1oje|n3ay

Manufacture/Type
420-450 MHz LAIRD or ANTENEX/G420BN
450-470 MHz LAIRD or ANTENEX/G450BN

Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

® EN 60950-1:2006:+A1:2009 & A1:2010
® ETSIEN300113-1V1.7.1(2011-11)
® ETSIEN 300 113-2V1.5.1(2011-11)
® ETSIEN 301 489-1V1.9.2 (2011-09)
® ETSIEN 301 489-7 V1.3.1 (2005-11)

Community of Europe Compliance P/N: 1001826-01 926



This equipment is intended to be marketed in the following countries:

List of National Codes:

Community of Europe Compliance P/N: 1001826-01 97

ETSI EN 301 908-1 V/5.2.1 (2011-05)
ETSI EN 301 908-2 V/5.2.1 (2011-07)
ETSI EN 300 328 VV1.7.1 (2006-10)
ETSI EN 301 489-3 VV1.4.1 (2002-08)
ETSI EN 301 489-24 V1.4.1 (2009-05)
ETSI EN 301 489-24 V1.5.1 (2010-10)
ETSI EN 301 489-17 V2.1.1 (2009-05)
ETSI EN 301 511 V9.0.2 (2003-03)

EN 62311:2008

A1oje|n3ay
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The equipment is labelled with a CE! mark that informs users the DIG UHFII frequency range 410-470 MHz is not harmonized
throughout Europe and the specific country spectrum authority should be notified before a radio modem is used.

430,

A1oje|n3ay

Use of this equipment requires a license.

L'impiego di questo impianto necessita una concessione.

Das Betreiben dieser Anlage unterliegt der Konzessionspflicht.

L'utilisation de cette installation nécessite une concession.

949 8 8

Community of Europe Compliance P/N: 1001826-01 98



Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky
[Czech]

Dansk
[Danish]

Deutsch
[German]

Eesti
[Estonian]

English

Espafiol
[Spanish]

(Sokkia) timto prohlasuje, ze tento (GRX2) je ve shod se
zakladnimi pozadavky a dalSimi pislusnymi ustanovenimi smrnice
1999/5/ES.

Undertegnede (Sokkia) erkleerer herved, at fglgende udstyr
(GRX2) overholder de veesentlige krav og gvrige relevante krav i
direktiv 1999/5/EF.

Hiermit erklart (Sokkia) dass sich das Gerat (GRX2) in
Ubereinstimmung mit den grundlegenden Anforderungen und den
ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Kéesolevaga kinnitab (Sokkia) seadme (GRX2) vastavust direktiivi
1999/5/EU p&hinduetele ja nimetatud direktiivist tulenevatele
teistele asjakohastele satetele.

Hereby, (Sokkia) declares that this (GRX2) is in compliance with
the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Sokkia) declara que el (GRX2) cumple
con los requisitos esenciales y cualesquiera otras disposiciones
aplicables o exigibles de la Directiva 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1001826-01
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[Greek]

Francais
[French]

Italiano
[Italian]

Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti
[Maltese]

ME THN NAPOYZA (Topcon Positioning Systems,
Inc.) AHAQNEI OTI (GRX2) ZYMMOPOQNETAI
MPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ ACIMNEZ
ZXETIKEZ ATATAZEIZ THZ OAHINAZ 1999/5/EK.

Par la présente (Sokkia) déclare que I'appareil (GRX2) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Con la presente (Sokkia) dichiara che questo (GRX2) & conforme ai

requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla
direttiva 1999/5/CE.

Ar 30 (Sokkia) deklar, ka (GRX2) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.
Siuo (Sokkia) deklaruoja, kad Sis (GRX2) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (Sokkia) dat het toestel (GRX2) in

overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (Sokkia), jiddikjara li dan (GRX2) jikkonforma mal-
tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm fid-
Dirrettiva 1999/5/EC.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1001826-01
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Magyar
[Hungarian]

Polski
[Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Suomi
[Finnish]

Svenska
[Swedish]

Alulirott, (Sokkia) nyilatkozom, hogy a (GRX2) megfelel a
vonatkozo6 alapvetd kovetelményeknek és az 1999/5/EC iranyelv
egyéb elbirasainak.

Niniejszym, (Sokkia), deklaruj, e (GRX2) spenia wymagania
zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

(Sokkia) declara que este (GRX2) esta conforme com os requisitos
essenciais e outras disposi¢des da Directiva 1999/5/CE.

(Sokkia) izjavlja, da je ta (GRX2) v skladu z bistvenimi zahtevami
in ostalimi relevantnimi doloili direktive 1999/5/ES.

(Sokkia) tymto vyhlasuje, Zze (GRX2) spa zakladné poziadavky a
vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Sokkia) vakuuttaa taten etta (GRX2) tyyppinen laite on direktiivin
1999/5/EY oleellisten vaatimusten ja sitd koskevien direktiivin
muiden ehtojen mukainen.

Harmed intygar (Sokkia) att denna (GRX2) star |
Overensstdmmelse med de vasentliga egenskapskrav och 6vriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1001826-01
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring this product is
disposed of correctly, to help prevent potential negative consequences for the environment and human health, which could
otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and
recycling of this product, please contact a supplier where you purchased the product or consult.

A1oje|n3ay

I
Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

® Baseband
* HCl
® Link Manager

® Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid for any antenna

with the same or less gain.

WEEE Directive P/N: 1001826-01 102



Glossary

Glossary

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for nearby Rover (mobile)
GNSS receivers.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short distances from
fixed and mobile devices.

C
COMPASS — BeiDou Navigation Satellite System maintained and operated by China.

G
G-GPS L1 only

GALILEO — The satellite system currently being maintained and operated by the European Union (EU) and European Space Agency
(ESA).

GD - GPS dual frequency
GG — GPS + GLONASS L1 only
GGD — GPS + GLONASS Dual Frequency signal tracking.

P/N: 1001826-01 103



GLONASS — The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS - Global Navigation Satellite Systems, such as GPS and GLONASS.
GPS - The Global Positioning System maintained and operated by the United States Department of Defense.

Aiesso|n

L
L1 — The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.
L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s components and
control receiver operations.

M
MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of the MAGNET
software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

N

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK corrections to the
Rover.

P/N: 1001826-01 104
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Option Authorization File (OAF) — This enables the specific features that a customer purchases.
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P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward, with the phase of
the signal being equal at any point on the sphere.

Pocket-3D - Field controller software by Sokkia that supports both GNSS and TS.

R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the measurement quality
without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.

Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS transmits differential
corrections and messages for navigation satellites that are within sight of a network or reference stations in a wide area, such as
a continent.

Sokkia Receiver Utility (SRU) — Hardware configuration software for receivers and peripheral devices. SRU is included on the
GPS+ Software CD that accompanied your receiver.

P/N: 1001826-01 105



Static Survey — Typically uses a network or multiple baseline approach for positioning. This method provides the highest
accuracy and requires the longest observation times.
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u
Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer, etc.
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